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  Combate à Cópia Ilegal


  A cópia ilegal é crime. Ao efetuá-la, o infrator estará cometendo um grave erro, que é inibir a produção de obras literárias, prejudicando profissionais que serão atingidos pelo crime praticado. Junte-se a nós nesta corrente contra a pirataria. Diga não à cópia ilegal.


   


  Fale Conosco!


  Eventuais problemas referentes ao conteúdo deste livro serão encaminhados ao(s) respectivo(s) autor(es) para esclarecimento, excetuando-se as dúvidas que dizem respeito a pacotes de softwares, as quais sugerimos que sejam encaminhadas aos distribuidores e revendedores desses produtos, que estão habilitados a prestar todos os esclarecimentos.


   


  Os problemas devem ser enviados pelos seguintes meios:


  E-mail - civil.galeano@gmail.com

  Fone - (11) 98997.0747

  Carta - Rua Verbo Divino, 2001 Cj. 152 Sao Paulo, SP CEP:04719-002
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  Requisitos de Hardware e Software


  Drive de CD ou acesso a Internet é necessário para instalação do produto. A configuração mínima do sistema para instalação é a seguinte:


  


  Sistema Operacional


  
    	Windows 7, Windows 7 (64-bit)


    	Windows Vista (incluindo Home Premium, Business e Ultimate)


    	Windows Vista (64-bit)


    	Windows XP (incluindo Home, Professional e Media Center), SP2 ou superior


    	Windows XP Tablet PC Edition e Windows XP Professional (64-bit)


    	Windows Server 2003, SP1 ou superior


    	Windows Server 2003 (64-bit)


    	Windows Server 2008 (incluindo Standard e Enterprise), SP2 (64-bit)


    	Microsoft Internet Explorer v6.0 ou superior

  


  


  Softwares


  Para MicroStation V8i v08.11.09.xx – Pacote de Pré-Requisitos do MicroStation V8i v08.11.09.xx deve ser executado ANTES da instalação do MicroStation V8i v08.11.09.xx. O conteúdo inclui:


  
    	Windows Installer Version 3.1v2


    	Microsoft .NET Framework 3.5


    	Microsoft XML Parser (MSXML) 6 SP 1 (32-bit e 64-bit)


    	Microsoft Visual Basic for Applications core


    	Microsoft Visual Basic for Applications localized


    	DirectX 9c


    	DHTML Editing Control for Applications (com compatibilidade Vista)

  


  Na edição SELECTseries 3, este pacote é instalado durante a instalação. Caso o componente já esteja instalado no seu sistema, ou seja mais recente, ele não será instalado.


  


  Perfil Mínimo


  O perfil mínimo de uma estação de trabalho para rodar o MicroStation V8i é:


  
    	
Processador – Processador Intel® ou AMD 2.0 GHz ou superior


    	
Memória - Mínimo de 512MB, 2GB recomendado. Mais memória melhora o desempenho, particularmente quando for trabalhar com grandes modelos.


    	
Hard Disk - 900MB de espaço livre (incluindo 400MB da instalação completa)


    	
Vídeo - Placas suportadas pelo DirectX 9.0. Consulte o fabricante da placa gráfica para informações mais recentes sobre os drivers DirectX. Se nehuma placa gráfica com suporte ao DirectX for encontrada, o MicroStation tentará usar uma emulação. Pelo menos 256 MB de RAM de vídeo é recomendado. Para melhorar o desempenho, a profundidade de cores exibida deverá ser ajustada para 24-bit ou superior. Se usar 16-bit, algumas inconsistências serão notadas.

  


  Sobre a Bentley Systems


  Como a empresa líder mundial voltada ao fornecimento de soluções em softwares abrangentes para o ciclo de vida da infraestrutura, a Bentley acredita no papel crucial que a infraestrutura deve desempenhar no auxilio à sociedade e na preservação do meio ambiente. A Bentley já comprovou que os aplicativos que auxiliam engenheiros, arquitetos, empreiteiros, governos, instituições, concessionárias e Owner Operators, constroem e operam de maneira mais produtiva, colaboram de maneira mais global e fornecem recursos de infraestrutura com desempenho mais sustentável.


  


  Com mais de 2.700 funcionários, escritórios em mais de 45 países e receitas anuais ultrapassando 500 milhões de dólares, a Bentley Systems investiu mais de 1 bilhão de dólares em pesquisa, desenvolvimento e aquisições desde 1995.
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  "Não é o mais forte que sobrevive, nem o mais inteligente, mas o que melhor se adapta às mudanças."


  Charles Darwin


   


   


   


   


   


   


   


   


   


   


   


  Prefácio


   


  Escrever o prefacio desse livro do Galeano é um privilégio e uma grande emoção. Depois do primeiro livro sobre o MicroStation escrito há alguns anos, e do surpreendente resultado, todos percebemos a necessidade de tentar publicar novas versões do livro que acompanhassem o próprio desenvolvimento do produto.


  O Brasil vive um momento único... Sou engenheiro há quase 30 anos e durante todo esse período ouvi dizer que seriamos o país do futuro. Ainda que o futuro, em minha opinião, ainda não tenha chegado, respiramos hoje um ar diferente. O país pede engenheiros para tocar os seus projetos, as obras dos grandes eventos estão aí e tem data de entrega, a infraestrutura ganhou uma importância que nunca eu havia visto. Aeroportos, rodovias, ferrovias, entorno urbano, tudo ficou importante nesse mundo que tentamos fazer ser sustentável. Este é o motivo que me sinto privilegiado. Acredito que é através do ensinamento, da critica, e do esforço de cada um de nós que vamos dar a nossa contribuição ao Brasil. Não precisamos de pirataria, não precisamos de jeitinho e não precisamos de falta de conhecimento. Tudo isso vai, em algum momento, ficar para trás. Iniciativas como a do Galeano nos movem para o lado correto.


  Aliado a tudo o que comentei acima, vale também lembrar que temos poucas publicações voltadas aos produtos da Bentley no Brasil. A maioria delas já esta desatualizada. Uma publicação como essa pode aproximar o leitor de uma ferramenta poderosa e flexível, e, de certo modo, contribuir com o momento de nosso país. Eis o motivo da emoção que sinto. O projeto nasceu e ganhou corpo e forma. E agora esta disponível para profissionais dos mais diversos setores da engenharia, para os estudantes que em pouco tempo estarão no mercado de trabalho e deverão estar prontos para as exigências do mercado; e até mesmo aos curiosos que querem aprender um pouco mais.


  O Galeano, um amigo de muitos anos, é um apaixonado pela tecnologia de Bentley e conhece como poucos, não só o produto, mas principalmente como o usuário brasileiro “funciona”, em termos de aprendizagem. Este livro, mais que um conjunto de comandos que foram traduzidos para o português, conduz o leitor a um processo fluído de aprendizagem, com exemplos e situações cotidianas. Os exemplos vão servir para o primeiro contato, mas também para o dia a dia de um usuário muito mais acostumado a trabalhar com o MicroStation.


  Quando visitamos empresas interessadas em treinamento comentamos que sempre há inúmeras alternativas para obter um resultado. Porém, a experiência é muito importante. A experiência ajuda a encontrar os melhores caminhos. Um dos objetivos do autor é ensinar a você, leitor, quais são os melhores caminhos. Por isso, se você é um marinheiro de primeira jornada, minha sugestão é começar pelo começo. Vá ganhando conhecimento seguindo a sequência lógica de como o livro foi escrito. Tudo o que você aprender vai ser útil para seu desenvolvimento no produto.


  Tenho convicção que a leitura desse livro vai trazer benefícios a você, leitor. Boa jornada!


   


  Salvio Lerner


  Diretor Técnico


  Bentley Systems America Latina
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  1 - Bem-Vindo ao MicroStation

  V8i (SELECTseries 3)


  
    

  


  Este capítulo vai ajudar o novo usuário a se familiarizar com as ferramentas e características encontradas no ambiente de desenho do MicroStation.
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  O Formato do Arquivo


  O formato nativo do MicroStation é o DGN. A extensão default para um arquivo de desenho do MicroStation é “.dgn”. O arquivo de desenho do MicroStation é definido usando coordenadas de dupla precisão. Isto proporciona um alto nível de precisão nas coordenadas para todas as necessidades de um desenho e projeto. Existem duas versões do formato DGN, pré-V8 e V8.


  



  


  Suporte DWG


  O suporte nativo ao formato DWG 2012, incluindo versões anteriores, proporciona um ambiente híbrido que oferece menos retrabalho e perdas durante a troca de dados.


  



  Modelos


  Um modelo é um contêiner independente que armazena informações gráficas e parâmetros específicos. Os arquivos de desenho do MicroStation podem conter múltiplos modelos.


  



  


  Interface Baseada em Tarefas


  Interface baseada em tarefas proporciona um método conveniente de agrupamento de ferramentas de uso comum para facilitar o fluxo de trabalho. O conjunto de ferramentas pode ser formado por ferramentas do MicroStation, por ferramentas customizadas ou pela combinação de ambas.
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          Iniciando o MicroStation

        
      

    
  


  


  Você pode iniciar o MicroStation usando um dos seguintes métodos:


  


  
    	
A partir do menu Iniciar do Windows, selecione o grupo de programas Bentley, e em seguida escolha o item MicroStation V8i (SELECTseries 3) > MicroStation V8i (SELECTseries 3).
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    	Na Área de Trabalho dê um duplo clique sobre o ícone do MicroStation.
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    	A partir do Windows Explorer, dê um duplo clique sobre um arquivo com a extensão DGN.

  


  


  A instalação default dos dados do programa no Windows XP fica localizada na pasta \Document and Settings\All Users\Dados de Aplicativo\Bentley\MicroStation. No Windows Vista e Windows 7 fica em \ProgramData\Bentley.


  


  


  Atenção: Você não pode ter mais de um arquivo de desenho aberto ou ativo no MicroStation ao mesmo tempo. Se abrir um arquivo de desenho quando um já estiver ativo, o MicroStation automaticamente fecha o primeiro. Todavia, você pode visualizar o conteúdo de outros arquivos de desenho, anexando-os como referência ao ativo.
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          A Caixa de Diálogo File Open

        
      

    
  


  


  Quando você inicia o MicroStation a caixa de diálogo File Open aparece. Sua função básica é navegar entre pastas e arquivos de desenhos e abrir estes arquivos.
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  Para listar um tipo específico de arquivo, clique sobre a seta do campo Tipo na parte inferior da caixa. Uma lista de todos os tipos de arquivos disponíveis será exibida. Quando você seleciona um tipo específico de arquivo, os arquivos listados acima somente serão aqueles com a extensão correspondente.
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  As funcionalidades das caixas nativas do Windows ficam disponíveis quando você seleciona um arquivo. Por exemplo, você pode clicar com o botão direito sobre um arquivo listado e mudar o nome do arquivo, excluir, criar subpastas, exibir o tamanho, tipo, datas de modificação, ou ainda mudar a ordem de exibição.


  


  A janela Preview image localizada do lado direito da caixa de diálogo exibe imagens do arquivo selecionado. Informações complementares sobre o arquivo selecionado aparecem na parte de cima da janela. Estas informações indicam se um arquivo DGN é 2D ou 3D e a versão do MicroStation. A versão do formato do arquivo é exibida para os arquivos do AutoCAD. Se o arquivo for de uma versão mais antiga do MicroStation, nenhuma imagem de preview será exibida.


  


  As imagens são exibidas normalmente para arquivos da geração V8 do MicroStation e para versões mais recentes do AutoCAD.


  


  
    
      
        	
          Imagem Thumbnail

        

        	
          Arquivo associado
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          Arquivos DGN da geração V8 e versões mais recentes do formato DWG.
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          Arquivos DGN da geração V8 e versões mais recentes do formato DWG, quando uma imagem não estiver disponível.
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          MicroStation/J e versões mais antigas do MicroStation.
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          Versões antigas do formato DWG.

        
      

    
  


  


  Se a opção “Abrir como somente leitura” na parte inferior da caixa for ativada, os arquivos serão abertos neste estado, disponíveis somente para visualização e impressão. Esta opção protege você de acidentalmente modificar um arquivo.


  



  


  Workspaces


  Um Workspace é uma configuração customizada do MicroStation que foi definida pelo Administrador ou CAD Manager. Ao selecionar um Workspace, você customiza o MicroStation para uma disciplina específica, projeto ou tarefa.


  


  O MicroStation é fornecido com uma variedade de Workspaces contendo arquivos de exemplo, os quais mostram muitas das convenções do MicroStation. Quando um Workspace está ativado, os arquivos e ferramentas que você precisa para realizar um trabalho específico são disponibilizados por default. As ferramentas que não são necessárias são removidas da interface. Para selecionar um Workspace, defina os campos User e Project na caixa de diálogo File Open.
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          EXERCÍCIO: Selecionando um ambiente de trabalho

        
      

    
  


  


  
    	Inicie o MicroStation.


    	No canto inferior direito da caixa de diálogo File Open, defina o campo User para “Examples”.


    	Mude o campo Project para “General”.


    	Na lista de arquivos, selecione o arquivo chamado “_Whats New_.dgn”. Clique sobre o botão Abrir.

  


  


  



  Você verá a janela de aplicativo do MicroStation com o conteúdo do arquivo aberto. Este é um arquivo de exemplo enviado com o MicroStation. Este arquivo apresenta exemplos de tipos básicos de geometria que você usa quando cria desenhos. Existem outros arquivos no projeto “Examples” que ajudarão você a se familiarizar com os elementos e conceitos básicos do MicroStation.
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          Visão Geral da Interface

        
      

    
  


  


  O MicroStation é uma ferramenta de CAD que pode ser utilizada em diversas áreas de engenharia, geoprocessamento e arquitetura. A imagem abaixo identifica as características mais relevantes do MicroStation


  [image: Image]


  O Menu do MicroStation


  A barra de menu principal está localizada ao longo da parte de cima da janela do aplicativo. É uma das principais fontes de comandos para controlar as operações do MicroStation. Conforme você seleciona cada menu, uma lista de itens de menu aparece. Cada item de menu inicia diretamente uma operação, ou abre uma caixa de diálogo onde você poderá definir a operação desejada.


  


  A barra de menu do MicroStation é muito bem organizada onde os comandos estão agrupados de uma forma lógica.


  


  
    	Se você estiver procurando por uma ferramenta específica, selecione o menu Tools. Este menu lista a maioria das ferramentas disponíveis no MicroStation.


    	Se você precisar ajustar os parâmetros do arquivo de desenho, selecione o menu Settings (parâmetros) e então procure pelo item de menu chamado Design File (arquivo de desenho). Neste livro isto será descrito como “Settings > Design File”.

  


  



  A Barra de Status


  A barra de Status é uma parte muito importante da interface com o usuário uma vez que ela oferece uma visão da operação do MicroStation. O MicroStation continuamente exibe informações sobre suas operações na barra de Status. As mensagens incluem o nome da ferramenta atual, o seu passo seguinte, informações sobre a ação anterior e o status de certas características.
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  Clique em diferentes ferramentas da caixa de ferramentas Main e da caixa de diálogo Task, e veja como as mensagens do lado esquerdo da barra de Status mudam. O nome da ferramenta é seguido por uma mensagem que instrui como iniciar o uso da ferramenta.


  


  Um pouco mais do lado direito você encontrará o centro de mensagens, ou Message Center.
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  São diversas informações exibidas aqui, como a última medida, por exemplo.
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  Clique sobre a mensagem, ou sobre a área em branco se não estiver aparecendo nenhuma mensagem, para abrir a caixa de diálogo Message Center. Ela permite que você revise informações anteriormente exibidas e outros tipos de mensagens. Em certos casos, um ícone indicando o tipo de mensagem será exibido.


  



  A Caixa de Ferramentas Main


  A organização central das ferramentas do MicroStation é na caixa Main. Ela é usada para selecionar ferramentas para manipulação, modificação e seleção de elementos.
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  Atenção: Quando você pressiona e mantém pressionado o botão esquerdo do mouse sobre uma ferramenta da caixa de ferramentas Main, você vê um menu que dá acesso a todas as ferramentas desta caixa. Este menu é chamado de menu pop-up.


  



  


  Você pode abrir uma caixa de ferramentas individualmente clicando sobre uma ferramenta e selecionando o item de menu “Open ‘nome’ as ToolBox” do menu pop-up. Você pode então colocar a caixa de ferramentas em qualquer lugar, ou ainda embutir a caixa na interface onde for mais conveniente.
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  Você pode definir qual, ou quais, as ferramentas exibidas na caixa de ferramentas ao clicar com o botão direito sobre a caixa e selecionar as ferramentas desejadas.


  


  Existem duas ferramentas que não possuem uma caixa de ferramentas associada, Element Selection <1> e Delete Element <8>.


  



  Mapeamento do Teclado


  O MicroStation usa um foco gerenciado para seguir suas ações. Neste sistema, o nível mais alto é chamado de Home. Olhe para o ícone de uma “Casa” localizado no lado direito da barra de status. Se ele não estiver lá, outro ícone indica que o foco está atualmente em outra janela em particular.


  


  As ferramentas podem ser acessadas usando o mouse ou usando o teclado, isto porque cada ferramenta está mapeada para uma combinação de teclas do teclado. A partir do ícone Home, pressione a tecla que corresponde à ferramenta que você quer usar. A imagem abaixo mostra a tarefa para quais as teclas dos números estão mapeadas.
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  Quando você acessa uma ferramenta da caixa de ferramentas Main você usa uma combinação de teclas. Pressionando a tecla <3> você abre o menu pop-up que lista as ferramentas da tarefa Manipulate. Pressione novamente a tecla <3> para ativar a ferramenta que estiver na terceira posição na caixa, neste caso Scale; ou você poderia ter pressionado a combinação de <3>+<9> para ativar a ferramenta Move Parallel. Pressione <7> para abrir a tarefa Modify, e em seguida <2> para ativar a ferramenta Break Element, ou <6> para a ferramenta Trim Multiple.


  Se você deseja usar o mapeamento do teclado, o formato usado para selecionar as ferramentas neste treinamento será: “Selecione a ferramenta Place SmartLine <Q>+<1>”.
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          EXERCÍCIO: Acessando uma ferramenta através do teclado

        
      

    
  


  


  
    	Continuando no arquivo “_Whats New_.dgn”, olhe para o lado direito da barra de Status para encontrar o ícone Home.

  


  [image: Image]


  
    	Se o ícone não estiver ativado, pressione a tecla <Esc>.


    	Deixe o ponteiro do mouse no centro da tela e então pressione <3>. O menu pop-up da tarefa Manipulate será expandido sob o ponteiro. Ele abriga todas as ferramentas de manipulação dos elementos. Você pode selecionar a ferramenta a partir deste menu, ou clicar no ícone da caixa de ferramentas Main e manter o botão pressionado para selecionar a ferramenta.

      [image: Image]

    


    	Pressione novamente a tecla <3>.


    	Observe a janela Tool Settings. Ela muda para mostrar todos os parâmetros da ferramenta ativa.

  


  Atenção: Sempre observe a janela Tool Settings e a barra de Status para saber qual ferramenta está ativada.


  



  


  Caixas de Diálogo e Alertas


  As caixas de diálogo aparecem sempre que você selecionar um item de menu que for seguido por reticências (...), itens como “Open”. Entre com as informações apropriadas e em seguida selecione a ação como OK, Done ou Apply (ok, feito ou aplicar). As caixas de alerta aparecem sempre que você está fazendo algo no arquivo DGN que seja difícil de reverter. Leia com atenção e selecione o botão com cuidado.


  



  


  Tarefas


  Uma tarefa é simplesmente um agrupamento lógico de ferramentas. A caixa de diálogo Tasks organiza uma enorme coleção de ferramentas para serem usadas.


  Clique sobre a barra Tasks no alto da caixa de diálogo Tasks, do lado esquerdo da janela do aplicativo, para abrir a lista de tarefas. As ferramentas encontradas nesta caixa de diálogo são usadas para colocar elementos no desenho. O MicroStation oferece como default, as tarefas Drawing e Drawing Composition.


  


  Use a caixa de diálogo Tasks embutida na interface do MicroStation, preferencialmente do lado esquerdo da janela do aplicativo. Todas as ferramentas são listadas de uma forma hierárquica a partir do alto da caixa. Quando você seleciona uma tarefa na lista, a tarefa e os ícones das ferramentas na caixa Main mudam.


  Atenção: Quando determinadas ferramentas que pertençam a uma tarefa ocupam a caixa de diálogo Tasks, somente é necessário pressionar uma única tecla! Apenas pressione a letra correspondente a ferramenta que você quer usar.
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          EXERCÍCIO: Navegando pelas tarefas

        
      

    
  


  


  
    	Continuando no arquivo “_Whats New_.dgn”, clique na seta ao lado da aba da caixa de diálogo Tasks para abrir a lista de tarefas.


    	Selecione a tarefa Town Task Example. A tarefa que preenche a caixa muda.

      [image: Image]

    


    	Clique sobre a tarefa Take Pictures. Observe os ícones do lado direito da aba da tarefa. Estes ícones mudam a forma como os ícones são apresentados.

      [image: Image]

    


    	Pressione <E> para ativar a caixa de diálogo View Attributes. Em seguida feche a caixa de diálogo.

      [image: Image]

    


    	Reabra a lista de tarefas. Então, selecione a tarefa Drawing para que ela ocupe a caixa de diálogo Task.

  


  [image: Image]


  



  


  Dicas das Ferramentas


  O MicroStation oferece dicas nas ferramentas para ajudar você a identificar a ferramenta sem ter que ativá-la. Conforme você move o ponteiro sobre uma ferramenta e faz uma pausa sobre ela, uma pequena etiqueta exibe o nome da ferramenta.


  À medida que você experimenta esta característica, note que isto também funciona na caixa de ferramentas Primary Tools, na barra de Status e em muitas outras caixas de diálogo. Na barra de Status deixe o ponteiro sobre o ícone Snap Mode, você vai notar a etiqueta e os parâmetros que estão ativados.


  [image: Image]


  Quando você move o ponteiro sobre uma caixa de ferramentas, o prompt do lado esquerdo da barra de Status muda junto com a etiqueta.


  [image: Image]


  Ao clicar sobre uma ferramenta, a barra de Status vai mostrar o nome da ferramenta e a orientação para o próximo passo.


  [image: Image]
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  Iniciando e Parando uma Ferramenta


  Quando você trabalha com uma ferramenta do MicroStation o botão do LADO ESQUERDO do mouse é solicitado para que você entre com um ponto. Considere o botão SIM. “Sim, eu quero selecionar esta ferramenta ou esta opção”; ou ainda, “Sim, eu quero entrar com este ponto aqui”.


  


  Quando você trabalha com uma ferramenta do MicroStation o botão do LADO DIREITO é chamado de RESET. Você usa um Reset para voltar um passo durante uma operação ou para encerrar esta operação. Você pode considerar este botão como um NÃO.


  A primeira vez que você entra com um Reset, uma caixa de diálogo aparece. Ela pede para que você selecione a funcionalidade desejada para este botão. O default é para que ele obedeça ao comportamento do MicroStation, e não do Windows.


  [image: Image]


  Ao escolher a opção default, você pode pressionar o botão Reset e mantê-lo pressionado por um segundo para que apareça um menu chamado “menu pop-up do Reset”.


  [image: Image]


  Este menu oferece um acesso conveniente para algumas ferramentas, como Copy, Move, Scale e Delete. Existem também as opções Cut to Clipboard, Copy to Clipboard e Paste from Clipboard. As opções variam dependendo do elemento que estiver sob o ponteiro.


  Atenção: As ferramentas do MicroStation são persistentes no seu comportamento. Isto quer dizer que ao ativar uma ferramenta, ela ficará ativada até que você ative outra!


  



  A Janela Tool Settings


  A maioria das ferramentas possui parâmetros para controlar a sua operação. Eles aparecem na janela Tool Settings. Esta janela é aberta, por default, no início da sessão. Se você fechar esta janela, ela aparecerá novamente quando uma nova ferramenta for selecionada.
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          [image: Image]

        
      

    
  


  Atenção: Se a janela Tool Settings desaparecer e você não poder encontrá-la, alterne a sua exibição ao selecionar o item Tool Settings a partir do menu Settings (Settings > Tool Settings).


  



  


  


  O PopSet e a Janela Tool Settings


  O PopSet permite que a janela Tool Settings desapareça automaticamente quando o ponteiro se aproxima e fica parado por um segundo ao lado dela. Ao afastar o ponteiro, a caixa reaparece. Isto é habilitado e desabilitado através do ícone PopSet na caixa de ferramentas Primary Tools. Quando o ícone fica verde, sem uma barra sobre ele, significa que o PopSet está habilitado. Na cor vermelha com a barra sobre ele, o PopSet está desabilitado.
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  Janelas de Vista


  As janelas de vista do MicroStation são chamadas simplesmente de “Vistas”. Você pode abrir mais de uma vista para ajudar no processo de desenho. As janelas de vista são redimensionáveis, móveis e minimizáveis. O MicroStation pode abrir oito janelas de uma única vez. Todas são ativas, prontas para receber entradas e graficamente independente uma das outras. Chamadas de View 1, View 2, View 3 até View 8, elas proporcionam acesso direto aos seus dados. A razão para 8 vistas é simples, você pode querer diferentes partes do seu projeto, variando o grau de detalhe, de uma única vez.


  



  
    
      
        	
          [image: Descrição: C:\Users\Galeano\AppData\Local\Microsoft\Windows\Temporary Internet Files\Content.IE5\39B7F24B\MCj04348940000[1].png]

        

        	
          EXERCÍCIO: Abrindo uma janela de vista a partir do menu Window

        
      

    
  


  


  
    	Ainda no arquivo “_Whats New_.dgn”, selecione o menu Window > Views > 2.


    	Selecione a vista 2. A janela de vista abrirá no canto superior esquerdo da janela do aplicativo.

  


  Atenção: Fechar todas as janelas de vista de um arquivo DGN, não é o mesmo que fechar o arquivo. Ou seja, mesmo que você feche todas as janelas, o arquivo ainda permanecerá aberto. A barra de título do aplicativo exibe o nome do arquivo aberto.


  



  


  Caixas de Ferramentas de Vista para Cada Janela de Vista


  Para controlar o conteúdo de uma janela de vista, cada janela oferece os seus próprios controles de vista. Estes controles permitem mudar o conteúdo de uma vista sem afetar o conteúdo de qualquer outra janela de vista. Os controles estão localizados no canto superior esquerdo de cada janela de vista.


  


  Você pode mudar a localização dos controles de vista através das opções da caixa de diálogo Preferences. Para abrir a caixa de diálogo Preferences, a partir do menu Workspace selecione Preferences. Em seguida, selecione a categoria View Options.


  [image: Image]


  As janelas de vista também podem ser abertas e fechadas usando os controles da caixa de diálogo View Groups, no canto inferior esquerdo da janela do aplicativo. Esta caixa é aberta e embutida por default quando o MicroStation é iniciado.
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          EXERCÍCIO: Como mudar o layout da caixa da tarefa

        
      

    
  


  


  
    	Continuando no arquivo “_Whats New_.dgn”, clique sobre o controle View 2 da caixa de diálogo View Groups para fechar a janela de vista 2.

      [image: Image]

    


    	Clique sobre o controle View 8 para abrir a janela de vista 8.

  


  [image: Image]


  


  
    
      
        	
          [image: Descrição: C:\Users\Galeano\AppData\Local\Microsoft\Windows\Temporary Internet Files\Content.IE5\39B7F24B\MCj04348940000[1].png]

        

        	
          EXERCÍCIO: Usando os controles de vista

        
      

    
  


  


  
    	Continuando no arquivo “_Whats New_.dgn”, clique sobre o ícone do comando Fit View da barra de controles de vista da vista 8. Todos os elementos existentes são enquadrados na janela de vista. O comando funciona como o comando “Zoom Extends” do AutoCAD.

      [image: Image]

    


    	Pressione o botão RESET do mouse para encerrar o comando. Se esta for a primeira vez que você pressiona o botão RESET, clique sobre o botão OK na caixa de diálogo para definir o comportamento do botão.

      

Atenção: Você também pode enquadrar todos os elementos em uma janela de vista ao dar um duplo clique com o botão central (ou “roda”) do mouse.
    


    	Na barra de controles de vista da janela 8, clique sobre o ícone do comando View Previous. A vista exibe o conteúdo previamente definido.

      [image: Image]

    


    	Feche a janela de vista 8.
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          As Funções do Mouse no MicroStation

        
      

    
  


  


  


  O mouse é o primeiro dispositivo de entrada da interface do MicroStation com o usuário.


  Nos mouses com “roda”, o botão do lado esquerdo é o botão de dado. Clique nele para entrar com pontos, como os vértices de uma linha. Você também pode usá-lo para selecionar comandos e opções de menu a partir da interface. Pense neste botão como o botão do “SIM”.


  O botão do lado direito é o botão chamado RESET. Este botão possui diferentes funções dependendo do processo atual. Pense neste botão como o botão do “NÃO”.


  [image: Image]


  O mouse com três botões é frequentemente usado com o MicroStation. Se você usa um mouse com três botões, existe um botão para cada uma das funções mais comuns de entrada no MicroStation.


  



  


  O Botão de Dado


  O botão de dado é usado para selecionar ferramentas e itens de menu. É também usado para entrar com pontos para colocar e manipular elementos no arquivo de desenho e confirmar estas entradas.


  



  


  A Ferramenta Element Selection


  A ferramenta Element Selection é usada para selecionar elementos a partir do arquivo de desenho. É a ferramenta default do MicroStation, a não ser que outra ferramenta seja selecionada. Quando você abre o seu arquivo, você pode notar que a ferramenta Element Selection é selecionada.


  A ferramenta Element Selection é muito versátil. Ela não é usada somente para selecionar elementos, ela também pode ser usada para agrupar, modificar e mover os elementos, além de editar textos.


  


  Os passos para trabalhar com a ferramenta Element Selection, assim como para a maioria das ferramentas do MicroStation, são os seguintes:


  


  
    	Selecione a ferramenta.


    	Ajuste os parâmetros.


    	Siga as orientações da barra de Status.
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          EXERCÍCIO: O botão esquerdo e a ferramenta Element Selection

        
      

    
  


  


  
    	Continuando no arquivo “_Whats New_.dgn”, selecione a ferramenta Element Selection <1>.

      [image: Image]

    


    	Defina os seguintes parâmetros:

      [image: Image]

    


    	Mova o ponteiro sobre os elementos no arquivo de desenho. Conforme você move o ponteiro sobre os elementos, eles são destacados. A informação exibida (pop-up) ajuda você a identificar o tipo de elemento.

      [image: Image]

    


    	Mova o ponteiro sobre o texto “Graphic Display” e pressione o botão esquerdo sobre ele. O elemento será destacado, e manipuladores serão exibidos.

      [image: Image]

    


    	Mantenha o botão pressionado sobre o texto e mova o mouse para arrastar o texto para fora da folha.

      [image: Image]

    


    	Solte o botão.


    	Na janela Tool Settings da ferramenta Element Selection, clique sobre o ícone Clear para liberar o texto selecionado.

  


  


  



   AccuSnap


  Conforme você pode notar, você viu a informação pop-up que foi exibida junto com o ponteiro. Esta é uma característica do AccuSnap. Quando esta característica está ativada, e o ponteiro se encontra próximo de um elemento, o AccuSnap exibe a informação sobre este elemento. A principal função do AccuSnap é ajudar você a encontrar a localização precisa em um desenho, como a extremidade de uma linha ou o centro de um círculo.


  


  Com o AccuSnap tudo o que você tem a fazer é mover o ponteiro o mais próximo do ponto que você deseja capturar. O AccuSnap encontra o ponto e permanece ali até que você mova o ponteiro para outro lugar. Quando você captura um ponto, uma cruz amarela grossa é mostrada neste ponto. O próximo ponto que você entrar será colocado precisamente neste local.


  [image: Image]


  A seguir você vai rotacionar um texto. Para faze isto, você deve selecionar uma ferramenta de manipulação.


  



  


  
    
      
        	
          [image: Descrição: C:\Users\Galeano\AppData\Local\Microsoft\Windows\Temporary Internet Files\Content.IE5\39B7F24B\MCj04348940000[1].png]

        

        	
          EXERCÍCIO: Usando o botão esquerdo para confirmar uma entrada

        
      

    
  


  


  
    	Continuando no arquivo “_Whats New_.dgn”, selecione o ícone da ferramenta Copy na caixa de ferramentas Main. Mantenha o botão do mouse pressionado e escolha a opção Open ‘Manipulate’ as ToolBox. A caixa Manipulate abrirá. As caixas de ferramentas frequentemente usadas podem ser isoladas como esta e embutidas na interface para facilitar o acesso.

      [image: Image]

    


    	Selecione a barra de título da caixa de ferramenta Manipulate, e arraste-a para o lado direito da janela do aplicativo.


    	Solte o botão. A caixa de ferramentas será embutida verticalmente na interface.


    	Na caixa Manipulate, selecione a ferramenta Rotate. Esta ferramenta opera de diferentes maneiras através dos parâmetros oferecidos na janela Tool Settings.


    	Na janela Tool Settings, clique no menu de opções Method.


    	Selecione o método 2 Points.


    	Assegure-se de que a opção Copies esteja desativada.

      [image: Image]


      [image: Image]

    


    	Identifique o texto que você moveu para identificar o elemento que será rotacionado.


    	Entre com outro ponto no centro do texto para definir o ponto pivô, o ponto sobre o qual o elemento será rotacionado, conforme informado na barra de Status. O MicroStation coloca o objeto em um modo de rotação dinâmica.

      [image: Image]

    


    	Quando o elemento estiver na posição desejada, entre com mais um ponto para aceitar a nova rotação. Pressione o botão RESET para concluir o comando.

  


  


  



  O Botão Reset


  O botão Reset é usado para realizar as seguintes funções:


  
    	Redefine o comando para o passo anterior.


    	Retorna ao último desenho ou operação de edição depois de usar um comando de vista.


    	Rejeita o elemento atualmente identificado/selecionado e busca por outro elemento dentro da área de localização do ponteiro.
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          EXERCÍCIO: A primeira função do botão Reset

        
      

    
  


  


  
    	Continuando no arquivo “_Whats New_.dgn”, você vai colocar uma linha embaixo do texto.


    	
      Com o foco definido para Home, selecione a ferramenta Place SmartLine <Q>+<1>. Se o foco não estiver definido para Home, pressione a tecla <Esc>. Na janela Tool Settings defina os seguintes parâmetros:

      [image: Image]


      [image: Image]

    


    	Entre com um ponto embaixo do texto, do lado esquerdo para definir o início da linha. Um quadrado translúcido aparece neste ponto. Este é o compasso do AccuDraw, o qual ajuda você a desenhar com precisão.


    	Mova o ponteiro para o lado direito e aceite outro ponto embaixo do texto. Siga o eixo oferecido pelo AccuDraw.

      [image: Image]

    


    	Pressione RESET para parar com a colocação da linha. O MicroStation libera o ponteiro, mas deixa a ferramenta ainda ativada. A pausa no uso da ferramenta é a primeira função do botão Reset.

  


  Atenção: O botão RESET não cancela a ferramenta, ele redefine a ferramenta para o passo anterior.
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          EXERCÍCIO: A segunda função do botão Reset

        
      

    
  


  


  
    	Continuando no arquivo “_Whats New_.dgn”, na caixa de ferramentas Manipulate clique sobre o ícone do comando Copy.

      [image: Image]

    


    	Identifique o texto que você acabou de “sublinhar”.


    	O texto ficará anexado ao ponteiro do mouse. Você está pronto para copiar o texto, porém você precisa mudar o zoom para ajudar a copiar o texto para outro quadro. Ou seja, você precisa mudar o conteúdo da vista através de um comando de vista.

      [image: Image]

    


    	Na barra de comandos de vista da janela de vista 1, clique sobre o ícone do comando Zoom In. Em seguida entre com um ponto no canto superior esquerdo da folha para envolver o quadro onde você pretende copiar o texto (onde ele estava anteriormente).

      [image: Image]


      [image: Image]

    


    	Clique sobre o botão RESET do mouse. Você retorna para o comando Copy.


    	Entre com um ponto para colocar a cópia do texto selecionado.


    	Pressione RESET para concluir a operação.

  


  


  



  O MicroStation permite que você realize operações com vistas durante os comandos de desenho e edição sem interferir na operação deste comando. Você não precisa se preocupar, pois a ferramenta não será cancelada, e nem terá o seu estado atual mudado.


  


  Quando você seleciona um comando de vista, apenas lembre-se de clicar o botão Reset somente depois que você concluir o ajuste da vista. Você vai retornar ao ponto de onde você acionou o botão Reset.


  


  Retornar a ferramenta anterior depois de usar comandos de vista, é a segunda função do Reset.
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          EXERCÍCIO: A terceira função do botão Reset

        
      

    
  


  


  
    	Continuando no arquivo “_Whats New_.dgn”, continue com a ferramenta Copy. Observe o pequeno círculo no ponteiro. Ele é o círculo da tolerância de localização. Ele aparece sempre que o sistema pede que você identifique um elemento.


    	Coloque o ponteiro sobre um dos elementos do quadro chamado “Wireframe”. O elemento sob o ponteiro muda de cor.

      [image: Image]

    


    	Entre com um ponto para aceitar a identificação.


    	Mova o ponteiro. Você pode ver o elemento anexado.

      [image: Image]

    


    	Pressione o botão RESET. O primeiro elemento é liberado e o próximo elemento muda de cor e é anexado ao ponteiro. O MicroStation busca pelos elementos contidos no circulo da tolerância de localização.

      [image: Image]
Esta tolerância é o quão próximo o ponteiro deve estar de um elemento para que ele seja reconhecido. Não importa quantos elementos estejam dentro desta área, o MicroStation irá buscar por todos eles, a não que você selecione um ou interrompa o comando.
    


    	Ao invés de ter que entrar com um ponto e um reset para cada elemento, você apenas entra com um ponto e depois que o elemento desejado estiver anexado ao ponteiro você pressiona o botão Reset.


    	Pressione o botão Reset depois que todos os elementos tenham sido liberados.

  


  


  Buscar por elementos elegíveis é a terceira função do botão Reset. Quando o MicroStation pede para você selecionar ou identificar um elemento, o elemento selecionado é destacado. Se o MicroStation destacar o elemento errado, pressione o botão Reset para liberar este elemento e selecionar o próximo elemento dentro da área de localização de elementos.
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          MicroStation Design Files

        
      

    
  


  


  Design Files, ou simplesmente DGN, é o nome do arquivo de armazenamento de dados primários do MicroStation que leva a extensão de arquivo DGN. O termo Design é frequentemente trocado por “drawing” (ou “desenho”, em português).


  


  Entretanto, um “Design” é uma coleção de elementos que são desenhados em escala real que abrigam parte de um projeto com o propósito de edição. Um “Drawing” é uma coleção de elementos e outros itens com o propósito de publicação.


  



  


  Fechando os Arquivos


  Você terminou o que estava fazendo no arquivo que está aberto e deseja fechá-lo. Porém existe mais trabalho por fazer no MicroStation, e você não quer fechar o aplicativo. Você apenas quer fechar o arquivo atual.


  


  
    	Selecionando o menu File > Open, você poderá escolher o próximo arquivo que você deseja abrir. O arquivo que atualmente estiver aberto será fechado, e o arquivo selecionado será aberto.


    	Selecionando o menu File > Close, você fecha o arquivo atual e retorna para a caixa de diálogo File Open.
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          EXERCÍCIO: Para fechar um arquivo de desenho

        
      

    
  


  


  
    	Continuando no arquivo “_Whats New_.dgn”, a partir do menu File selecione Close. O arquivo atual fecha e você retorna a caixa de diálogo File Open.

  


  


  Você somente pode abrir um arquivo por vez em uma sessão do MicroStation. Se você achar que você precisa ter dois arquivos abertos ao mesmo tempo, você pode iniciar outra sessão do MicroStation para abrir o outro arquivo. Apenas uma licença é usada para as duas sessões.


  



  


  Salvando Informações


  O método que o MicroStation usa para salvar informações é um pouco diferente dos outros aplicativos CAD. Quando você abre um arquivo para modificar no MicroStation, o programa lê os dados do Design a partir do arquivo armazenado no disco ou rede diretamente na memória RAM do computador local. Durante o processo de desenho o MicroStation periodicamente escreve as mudanças (salva) no arquivo aberto no disco. Isto difere dos outros aplicativos porque neles você precisa literalmente realizar uma operação para salvar as mudanças permanentemente no arquivo.
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